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Introduction

Welcome to Extensis Intellihance. You’ve just purchased an intelligent
tool that makes Adobe® Photoshop® work faster, easier and more
efficiently than ever before.

Intellihance improves the way your digital images appear in print or on
the screen by intelligently analyzing each image’s needs and then
automatically applying filters to optimize contrast, brightness, satura-
tion, sharpness and despeckle. All you need to do is click the Enhance
Image button.

Although we believe Intellihance’s default settings will satisfy the
majority of users most of the time, you can customize Intellihance’s
intelligent enhancement engine to analyze and enhance each image
according to your specifications.

We even provide a manual “Fine Tune” area for those few images that
you want to tweak a bit further.

Before Intellihance After Intellihance
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System and Software Requirements
To use Intellihance, you need the following equipment and software:

• Windows 3.1 with Win32s or Windows 95.

• Adobe Photoshop 3.0.4 or later, or other applications that accept
Photoshop Plug-ins.

Intellihance has been tested to work with the following applications:

• PageMaker 6.0

• Corel Photo-Paint 6

Note: While Intellihance should be compatible with other applications
that accept Adobe Photoshop Plug-ins, not all applications have been
thoroughly tested.

Software Installation

To install Intellihance:

1. Insert the Intellihance disk into the disk drive.

2. Windows 95 Users:
Click the Start button on the Windows 95 Task bar. The Start menu
appears. Select the Run item in the Start menu.

Windows 3.1 with Win32s Users:
Select Run in the Program Manager’s File menu.

4. In the Run dialog box, type A:\  Setup in the text field.

If you install from a different drive, substitute that drive letter for
“A.”

5. Click the OK button.

The Intellihance Setup application starts.

6. In the Welcome dialog box, click the Next button.

7. In the Destination Location dialog box, select a directory where
the supporting files (such as the ReadMe) will be installed.

A default directory is chosen for you. Click the Browse button to
select a different directory. Click the Next button.
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8. In the Select Application dialog box, Photoshop is already
selected for you.

To choose a different application with which Intellihance will work,
click the Browse button and locate the application’s Plug-ins or
Xtras directory. Click the Next button.

9. Windows 3.1 with Win32s Users: In the Select Program Group
dialog box, identify a location for the supporting files’ program
group.

10.A dialog box appears, notifying you that Setup is complete.

Click OK.

11. A dialog box appears, giving you the option of viewing the
ReadMe file. Click the Yes button to view it.

Installation is complete.

Registration
It is important to register your copy of Intellihance so we can provide
you with service. Registered users of Intellihance are eligible for
technical support, information regarding new versions and products,
discounts and special offers on new products.

Intellihance includes electronic registration, so registering has never
been easier! The first time Adobe Photoshop is launched after Intelli-
hance is installed, the Intellihance Personalize dialog box appears. To
personalize Intellihance, type your name, company and Intellihance
registration number. Your product registration number is located on
your Intellihance disk. If you choose not to personalize your copy,
Intellihance will run in a demonstration mode that lets you process five
images during a single Photoshop session. The demonstration mode
will expire after you have run Intellihance on 30 images. Your demo
will expire 45 days after installation, even if the 30 images limit has not
been reached. Purchase a registered copy of Intellihance by calling
Extensis at 1-800-796-9798.

The following files are installed
on your Windows system:

In the Plug-ins directory:
IntelCMY.8BF
IntelGS.8BF
IntelRGB.8BF

In the Intellihance directory:
Readme.txt
Ihance.hlp
Shtcomm.ast
Intel.gid
CMYK.tif
Grayscal.tif
RGB.tif

In the Windows System
directory:
EReglb16.dll
EReglb32.dll
Ergint16.dll
Ergint32.dll
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After you have personalized Intellihance, a dialog box appears asking if
you would like to register. To register Intellihance, click the Register
Intellihance button and an electronic registration dialog box appears.
After you’ve completed the registration dialog box, a Market Research
dialog box and a System Configuration dialog box will follow. The
Market Research dialog box asks basic questions which enable us to
better understand your needs. The System Configuration dialog box
provides a “snapshot” of your system configuration which enables
Extensis to support you more effectively. Sending the Market Research
and System Configuration information is optional, if you don’t want to
send this information to Extensis, you may check the checkbox at the
bottom of these screens.

If you have a modem connected to your computer, you can register toll-
free by modem. If you do not have a modem, you can print the registra-
tion sheet and register either by faxing it to (503) 274-0530 or mail it
using the postage-paid envelope provided. If you don’t have access to a
modem or printer, you can still register by filling out a registration
sheet located at the end of this manual.

Technical Support
If you have a question or problem that is not addressed in this manual,
please call technical support at 503-274-7030 Monday through Friday,
between the hours of 8:00 a.m. and 5:00 p.m., Pacific Standard Time.

When calling Technical Support, please be at your computer and have
the following information available.

• Your Intellihance registration number.

• Your Windows configuration.

• Your question or a description of the difficulty you’re experienc-
ing—what specifically occurs and when. Write down any displayed
error numbers or messages and any other information you think
may be helpful.

Suggestions
We’d love to hear your comments about Intellihance, ideas for new
plug-ins or improvements to Intellihance. A suggestion sheet is in-
cluded at the end of this manual. Please fax or mail your comments and
suggestions to Extensis.

Tip
You can send us a Fax at 503-
274-0530, or contact us through
one of these online services:

CompuServe : 70242,33
America Online : Extensis
E-Mail : support@extensis.com
Web: http://www.extensis.com
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Using Intellihance

Intellihance improves the way your images appear in print or on the
screen by intelligently analyzing each image and automatically adjust-
ing only the amount of contrast, brightness, saturation, sharpness and
despeckle needed to optimize the image. Intellihance measures the
amount of these variables in your original image, compares the mea-
surements with the preferences table and then automatically enhances
the image to match the preferences.

The Intellihance default preferences are based on the way most people
like to view images in print or on the screen. The best way for you to
decide if you like the default settings is to try them. Process a variety of
images with Intellihance, and look at the results. If you like what you
see, the default settings are fine for you.

Another excellent use of Intellihance is with graphics you’re preparing
for the Internet. Use Intellihance to optimize these images.

The following table lists the Intellihance default settings. If you want to
change the default preferences, go on to the next section, “Customizing
Intellihance.”

Intellihance Filter Default setting

Contrast Normal

Brightness Balanced Tone

Saturation Medium

Sharpness Medium Sharpness

Despeckle Off

The following procedure tells you how to use Intellihance with its
default settings—simply open an image in Adobe Photoshop, select the
Intellihance filter, and click OK. That’s all there is to it!

To process an image with Intellihance default
settings:

1. From Adobe Photoshop, open an RGB, CMYK or GS image
you’d like to process.

2. Open the Intellihance Quick Enhance dialog box by choosing
Filter > Intellihance > RGB or CMYK or GS.

3. When you see the Quick Enhance dialog box, click Enhance Image.
Once you have run Intellihance on your first image, you can use the
“Control-F” keyboard shortcut to enhance other images. The
Enhance Image dialog box appears the first time you use Intelli-
hance or if you select Intellihance from the Filters menu.
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To process an image using the before and after
previews:

1. From Adobe Photoshop, open an RGB, CMYK or GS image
you’d like to process.

2. Bring up the Intellihance Quick Enhance dialog box by choos-
ing Filter > Intellihance > RGB or CMYK or GS.

Intellihance automatically makes available the appropriate GS, RGB
or CMYK filter for your image in the pull-down menu (the other
filters are not available).

3. From the Quick Enhance dialog box, click the Preferences
button.

4. From the Intellihance Preview dialog box, click OK to process
the image.

The Preview dialog box shows you a preview of the original image
and the enhancements Intellihance proposes to make when you
process it.

Tips
You can use Control-Alt-F to
open the Quick Enhance
dialog box once the filter has
been run.

To display the Preview dialog
box every time you open
Intellihance, select the
Preferences dialog box
checkbox in the Preferences
settings.

The Preview dialog box

A Your original image. This is the “before”
view of your image.

B A preview of the filter adjustments
Intellihance will make to the image.  This is
the “after” view of your image.

C Click OK to process the image.

D Click Cancel to exit the Preview dialog
box.

E Selects a file of previously saved
preferences and loads them in the
Intellihance Preferences dialog box (Alt-L).

F Saves the current preference into a
directory and file of your choice
(Alt-S).

G Displays the Fine Tune dialog box that
allows you to manually adjust your image
(Alt-F).

H Displays Intellihance online help.

I When you move your mouse over the
preview image, the pointer becomes a
crosshair. Move the crosshair over the
Preview image to see the before and after
pixel readouts in CMYK, RGB, or GS values.

J Click this tab to customize the way
Intellihance applies its filters.

K Click for information about Intellihance and
Technical support.

K J

D

C

I

F

E

H

G

BA
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Customizing Intellihance

The Preferences dialog box

A Intellihance will process the current image
with the output settings defined in the
Preferences panel (Enter).

B Exits Intellihance with no changes
(Escape).

C Selects a file of previously saved settings
and loads them in the Intellihance
Preferences dialog box (Alt-L).

D Saves the current preference into a folder
and file of your choice (Alt-S).

E Displays the Fine Tune panel that allows
you to manually adjust your image (Alt-F).

F Displays Intellihance online help.

G When you move your mouse over the
preview image, the pointer becomes a
crosshair. Move the crosshair over the
Preview image to see the before and after
pixel readouts in CMYK, RGB or GS
values.

H Choose which Intellihance dialog box to
display as your default dialog box.

I Click to display the Preview dialog box.

J Click for information about Intellihance and
Technical Support.

K Intelligent Enhancement engine
preference pop-up menus.

You can customize the way Intellihance applies the contrast, brightness,
saturation, sharpness and despeckle filters. Choose these options in the
Preferences dialog box pop-up menus.

Intellihance analyzes and compares your original image to the output
settings you’ve chosen—and then automatically processes the image to
match your preferences. You determine the way you want your output
to appear. Make those selections from the menus in the Intellihance
Preferences dialog box, and then click OK to apply the changes. Then
you can apply the same set of preferences to multiple images. You can
also save different preference settings and load them at a later time.

Adjusting Intellihance Filters
You can adjust five separate filters from the Intellihance Preferences
dialog box. Each filter has a menu of predefined effects:

• Contrast

• Brightness

• Saturation (available with RGB and CMYK only)

• Sharpness

• Despeckle

J I

EH EG

EK

B

A

EE

C
D

EF
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Contrast

The Contrast filter gives you four options for adjusting tonal correction.
The Normal option will brighten highlights, darken shadows and
establish midtones for best overall contrast. Select the Soft option if
you want to maintain maximum shadow and highlight detail or if you
want to lower contrast overall. Select the Snappy option if you want
your image to have solid blacks and solid whites or to increase contrast.
Select the Hard Contrast option if you want images with high contrast
or if you want a posterized effect. If you don’t want any correction, you
can turn this filter Off .

Two additional options are available for special publishing applications.
Flatten Highlights may be useful when printing on newspaper to allow
you to use the paper itself to represent the highlight in the image.
Flatten Shadows may be useful when you want to push some shadow
noise into the blacks.

Soft Contrast

Hard Contrast

For a color example of this filter, refer to the inside front cover of this manual.
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Brightness

The Brightness filter adjusts or shifts various tonal groups. You can
shift shadows, midtones, or highlights, or balance the overall tone of
the image. This means, for example, that Intellihance can darken
overexposed photographs and lighten underexposed photographs. If
you don’t want any correction, you can turn this filter Off .

Brightness is a subjective adjustment. Try each of the settings for the
Brightness filter and see what you like best. After running the settings
on several images, you’ll discover which setting provides the most
desirable results.

Highlight EmphasisDeeper Shadows

Balanced Tone

For a color example of this filter, refer to the inside front cover of this manual.
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For a color example of Saturation and Sharpness filters, refer to the inside front
cover of this manual.

Saturation

The Saturation filter (available with RGB and CMYK only) is a color
correction filter for automatically adjusting the purity of the color. The
Medium option provides excellent results for most images. Intellihance
automatically examines the saturation of the input image and then will
increase or decrease the saturation according to the setting for this filter.
This is very useful with Photo CD images that are often oversaturated.
If you don’t want any saturation correction, you can turn this filter Off .

Saturation processing will increase the computing time. Unless you
have a powerful computer, you may want to allow extra time to process
images that need more adjustments.

Sharpness

The Sharpness filter sharpens soft images by increasing the contrast of
adjacent pixels.

Note for professional users: The Intellihance sharpness algorithm is
actually an “unsharp mask” algorithm.

Like Brightness, Sharpness is also subjective. Try each of the settings
for the Sharpness filter on several images and see what you like best. If
you don’t want any correction, you can turn this filter Off. Remember,
the Sharpness filter will not sharpen noisy images.

Note: On large images, the Preview dialog box may exaggerate the
sharpening effects.

Soft Sharpness

Extra Hard Sharpness
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Despeckle

The Despeckle filter removes noise, such as photograin or scanner-
induced noise, while preserving detail. Intellihance detects the edges in
an image (the areas where significant color changes occur) and gently
smooths all of the selection except those edges.

If you want to reduce image noise, this filter has three options that will
process only noisy pixels without changing highlights or other details.

The Overall option is useful for situations where the image may
contain speckles or photograin noise in the image. The Dark Tones
Only option is for images where you’re satisfied with your light tones
and only need to adjust dark tones. The Light Tones Only option is for
images you might enlarge such that the photograin in the highlights
becomes evident. These last two options allow you to limit the filtering
to the darker or lighter areas of the image. If you don’t want any
correction, you can turn this filter Off .

See “Scanning Tips” later in this manual for a simple method to assess
scanner noise.

Note: On large images, the Preview dialog box may exaggerate the
Despeckle effects.

Using the Intellihance Fine Tune Option
Although the power of Intellihance lies primarily in its ability to
automatically correct and enhance images with little or no user inter-
vention, you may occasionally want specific control of image adjust-
ments. You can use the Fine Tune dialog box to accomplish this. Fine
Tune conveniently locates a variety of separate Photoshop functions
into one dialog box. The preview shows you the effect of each adjust-
ment. You can preview your original image—without the effects—by
holding down the Control key.

Note: Intellihance processes the image using the preference settings
before you make any adjustments in the Fine Tune dialog box.
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A Click to apply adjustments to the image
(Enter).

B Exits Intellihance with no changes
(Escape).

C Returns to the settings of the original
image, before running Intellihance (Alt-L).

D Returns to the settings in effect when the
Fine Tune dialog box was selected (Alt-R).

E Allows you to navigate directly to the
Preferences dialog box from the Fine Tune
dialog box.

F Displays Intellihance online help.

G When you move your mouse over the
preview image, the pointer becomes a
crosshair. Move the crosshair over the
Preview image to see the before and after
pixel readouts in CMYK, RGB or GS values.

I Click these tabs to display controls for
each filter. (See pages 22-23 for
descriptions of these options.)

J Click for information about Intellihance or
Technical Support.

The Fine Tune dialog box

G

A
B
C

I

J

D
E
F

To manually fine tune an image:

1. Bring up the Intellihance Quick Enhance dialog box by choos-
ing Filter > Intellihance > RGB or CMYK or GS.

2. In the Quick Enhance dialog box, click the Preferences button.

3. Click the Fine Tune... button or press Control-F.

The Fine Tune dialog box appears.

4. Select the tab for the filter you want to adjust.

5. Move each slider to your desired position.

Intellihance will filter the image using the measurements from the
slider positions—while you watch.

Tip
To display the Fine Tune dialog
box every time you open
Intellihance, select the Fine
Tune Always checkbox from the
Preferences settings in the
Intellihance Preview dialog box.
Then, every time you select
Intellihance from the Filter menu
or press Control-Alt-F after
Intellihance has been run once,
the Fine Tune Dialog Box will
open.
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The order in which you apply the filters affects the output. We recom-
mend you use the following order.

1. Set the Tone. Set the white point as low as you can without
flattening important highlights. Set the black point as high as you
can without flattening the shadow data. Set the gamma or midtone
point for a balanced tone or to emphasize a key element in the
image.

2. Adjust the Sharpness. Sharpness can amplify noise if not applied
correctly. Set the radius at 2 or 3 depending on the ppi of the scan,
set the Amount % between 30-120% and set the Threshold
between 0-20. Note that on large images, the Preview dialog box
will exaggerate the sharpening effects.

3. Remove noise. The Despeckle filter reduces image noise. Set the
lower limit and upper limit to determine when noise removal
begins and ends. Typically, this filter is applied in the shadows.
Note that on large images, the Preview dialog box will exaggerate
the blurring effects.

4. Adjust Saturation.

For more information about each of the controls in the Fine Tune dialog
box, see “Enhancement Tips” later in this manual.

Color ConversionTable

When you want to convert RGB images to CMYK, you can use the
PixelCraft ColorAccess professional color conversion table included
with Intellihance. RGB scanners, Photo CD disks and stock photogra-
phy disks produce RGB images that must be converted to CMYK for
printing. If you’ve ever performed these conversions using other
CMYK conversion tables, you may have noticed:

• Color shifts in color you thought would be pure.

• Posterization or a flattening of highly saturated colors.

• Overall image darkness and a lack of definition in the shadows or
dull highlights.

• An overall magenta cast.

• A brownish cast in the shadows.

The PixelCraft conversion table, included on the Intellihance disk,
produces better conversions because the separation table maps the RGB
color gamut to the most printable CMYK colors. This reduces common
problems with CMYK separations that print too much ink.
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The PixelCraft color conversion table was set up especially for Intelli-
hance. PixelCraft conversion tables are based on industry-standard
“Skeletal Black” black generation algorithms and industry standard ink
sets. The table included with Intellihance emulates a sheet-fed offset
press using a commercial ink set on coated paper stock.

To use the color conversion table:

1. From the File menu, choose Preferences > Separation Tables....

The Separation Tables dialog box appears.

2. Click the Load button.

The File Load dialog box appears.

3. Find the PixelCraft conversion table in the Intellihance folder
on your hard drive.

(C:\Program Files\Extensis\Intellihance\Shtcomm.ast)

4. Select the Shtcomm.ast conversion table and click OK.

This table name displays next to the Use Table radio buttons and
will be used in all RGB to CMYK conversions. It will also be used
to view all CMYK data instead of Adobe Photoshop’s Printing Inks
Setup whenever you use Adobe Photoshop.

5. Select Mode > CMYK color.

You’ll watch the image change from RGB to CMYK color space.

To improve color separation results:

1. Calibrate the Printing Inks Setup in Adobe Photoshop.

Follow the calibration procedure in Calibrating Your System,
located in the Adobe Photoshop manual for entering the Printing
Inks Setup information.

2. Calibrate your monitor for tone correction.

Follow the calibration procedure in Calibrating Your System,
located in the Adobe Photoshop manual.

Tip
The Conversion Table’s dialog
box also converts CMYK images
to RGB for viewing CMYK data
on the screen.
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To improve Photo CD results:

A. Run Intellihance on your image using the default settings.

A Medium Saturation filter will compensate for Photo CD images
that are typically oversaturated and overexposed.

OR,

B. 1. Open your Photo CD image and convert it to a Lab image in
Adobe Photoshop (Mode > Lab Color).

2. Select the lightness channel by pressing Control-1 or by
clicking on the Lightness channel.

3. Run the Intellihance GS (grayscale) filter on the L channel.

4. View the entire image by pressing Control-0 or by choosing
the Lab channel.

5. If needed, run the appropriate Intellihance filter on the
entire image.

Saving and Loading Intellihance Filter Settings
After you set up Intellihance Filters with the specific adjustments you
want, you can save these settings and then use them automatically.

To save filter adjustments:

1. Bring up the Intellihance Quick Enhance dialog box by choos-
ing Filter > Intellihance > RGB, CMYK or GS.

2. In the Quick Enhance dialog box, click the Preferences button.

3. Make sure all the pop-up menus display the settings you want.

4. Click the Save Settings button or press Alt-S.

5. Select a directory and a name for the settings file.

6. Click Save.
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To load filter adjustments previously saved:

1. Bring up the Intellihance Quick Enhance dialog box by choos-
ing Filter > Intellihance > RGB, CMYK or GS.

2. In the Quick Enhance dialog box, click the Preferences button.

3. Click the Load Settings button or press Alt-L.

4. Select the directory and name of the settings file to use.

5. Click Open.

The Intellihance Preferences dialog box now displays your saved
settings in the pop-up menus.

Generating a Report of Changes to the Image
If you would like to see what Intellihance has done to the image, you
can generate a report by holding down the Control key when pressing
OK in the dialog box. The report gives you parameters that emulate
(although not exactly) Adobe Photoshop Levels and Unsharp Mask
settings.

Notice the Saturation Factor value. This is an indication of how much
the saturation increased or decreased. A value of 1.0 indicates Satura-
tion was unchanged. Desaturation occurs when this value is less than
1.0. To use this value in Adobe Photoshop, multiply this number by 100
and copy into the Hue/Saturation dialog box.

The % Despeckled value indicates what percentage of the image’s
pixels were filtered as noise pixels.
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Advanced Tips

Scanning Tips
You can use your scanner interface to control your scanner’s brightness,
color cast, white point and scan resolution.

Most scanner interfaces have various controls to set brightness,
contrast, gamma, highlight and shadow points. These controls, if used
improperly, can add noise or flatten the highlights and shadows of the
image. That’s why it’s best to turn off your scanner’s automatic
features.

To evaluate your scanner’s capabilities:

1. Open an image from Adobe Photoshop.

2. Choose Adjust > Levels from the Image menu.

The Levels dialog box displays showing the distribution of pixel
values in your image.

Checking your scanner’s white point

You can improve scans by properly setting your scanner’s white point,
that is, the reflective value the scanner sees as white or 0%. If your
picture is overly bright and the scanner’s white point is low, you may
be flattening your highlight data. This is especially noticeable when
scanning a calibration strip or an image with a broad tonal range.

Refer to the documentation provided in your scanner’s manual to set
the white point. Sometimes the brightness control can be used to set the
white point of the scanner. If you can’t seem to adjust the white point
properly, you may have a scanner that doesn’t allow you to set the
white point; these scanners typically adjust the white point in software.

Tip
Turning off your scanner’s
automatic features will capture
all the available data in the
image. If this makes the image
dark, Intellihance will automati-
cally compensate.

A good scan. Notice the smooth tapering of the
shadow and highlight data.

The white point is too low. Notice the spike at the
whitest point, indicating that highlight data has
been flattened. This means the highlight data
was scanned as white because these values
were whiter than the scanner’s white point.

The white point is too high. Notice the bunching
of data at the darkest point, indicating that the
shadow data has been flattened.
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Determining whether to use the Despeckle filter

If you want to determine whether to use the Despeckle filter, view
speckles or noise. Noise can be previewed directly by turning up or
increasing the contrast in the tones to an extreme. If the speckles are
severe, set the Despeckle filter menu to Dark Tones Only from the
Intellihance Preference dialog box. This will suppress shadow noise. If
you are processing a batch of images with severe photo grain noise, set
the Despeckle filter menu to Overall.

Determining the scan resolution

The capability of your output device determines the correct resolution
for a scan. As a general rule, to produce a high-quality halftone image,
the image resolution (measured in pixels-per-inch or ppi) should be 1.5-
2 times the lines-per-inch (lpi) value of the halftone screen used to print
the image. For example, to print a high-quality image using a 133-lpi
screen, you would need an image resolution between 200 and 266 ppi
(133 x 1.5 to 2.0). In some cases, however, depending on the image and
the output device, ratios of as low as 1.25 produce excellent results.

The size of the final image compared to the original image is also a
consideration in setting scan resolution. If the final output size is not
known, then overscan by a larger factor. For more information about
determining the final output size, refer to your scanner’s manual.

If you see excessive noise in your scans, your scanner may be taking
short cuts. Even though you want a scan at 225 ppi, many scanners will
scan the picture at 300 ppi and remove pixels electronically. In the case
of high resolution scans, it is common for a scanner to scan at 600 ppi
and add pixels to get 1200 ppi. This may result in speckle artifacts or
blurring. If you see excessive scanner noise, try scanning at 300 or 600
dpi and then scale the image in Adobe Photoshop. Remember the scale
factor affects the scan ppi.

For more information about determining the scan resolution, refer to
Scanning, Importing, and Exporting Images in the Adobe Photoshop
manual.

Tip
Use this formula to calculate
the pixels per inch:

ppi = lpi x 1.5 x scale factor

Tip

# of shades = (dpi/lpi)2

lpi ≈ dpi / √ # of shades
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Enhancement Tips
After you have processed an image with Intellihance, there are three
ways to further enhance the image.

1. Run Intellihance on the image again.

2. Use the Fine Tune adjustments.

3. Use other Adobe Photoshop filters and tools. Refer to the Adobe
Photoshop manual for more information about image enhance-
ment.

Running Intellihance on the image again

When Intellihance processes an image, it compares the input to the
settings in the Preferences dialog box and decides which filters to run to
make the output conform to those settings. Sometimes you can run
Intellihance again to gradually bring the image closer and closer to your
preferences.

You can also run Intellihance again to bring out the effects of a specific
filter. For example, maybe the sharpness of the image is good, but you
want more brightness. If you set the Sharpness filter to Off and run
Intellihance again, the Brightness filter continues to improve the
brightness of the image.

Try running Intellihance with the Despeckle filter set to Dark Tones
Only, and all other filters turned Off. This will clean up shadow
speckles caused by excessive scanner noise.

Using the Fine Tune adjustment

When you click the Fine Tune... button in the Intellihance Preview
dialog box, you can adjust sliders for Tone, Saturation, Sharpness and
Despeckle.

Tone

When you select the Tone tab, the Tone panel appears. The first slider
adjusts the shadow (dark tone) values in your image to become black or
the Black Point. The available numerical values are 0 to 253, where 253
is black (or 100% solid). Notice that if you adjust the Black Point to a
value higher than the mid Point, the mid point value slides up also.
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The second slider adjusts the middle tone values in your image. You
can adjust this slider from 0 to 254. If your image contains middle
tones (say, 25-75%) that you would like to darken or lighten overall,
adjust this slider. Mid Point, normally considered to be 50%, is repre-
sented by the value 128.

The third slider adjusts the light tone values in your image to become
white or the White Point. You can adjust this slider from 1 to 255,
where 255 is white (or 0% tone).

Saturation

When you select the Saturation tab, the Saturation panel appears. The
slider bar is calibrated in percentage with 0% in the center, -100% on
the left side and +100% on the right side. A positive percentage value
increases the color but not the neutral or gray value in your image. A
negative value decreases the color saturation. In other words, a satu-
rated color tends to be brighter and a desaturated color tends to stay the
same.

Sharpness

When you select the Sharpness tab, the Sharpness panel appears. The
Amount % slider bar has numerical values from 0 to 200%. The
Amount % increases relative sharpness of the image. The Radius slider
bar has values that range from one pixel to three pixels. Radius estab-
lishes the width of the sharpened edges. The Threshold slider bar has
values that range from 0 to 255. Higher Threshold settings reduce
sharpening of pixel and photo grain noise. We recommend values no
greater than 20.

Despeckle

When you select the Despeckle tab, the Despeckle panel appears. The
Amount % slider bar has numerical values from 0 to 200%. This slider
sets the amount of pixel noise removed. The Lower Limit slider bar has
values from 0 to 254. This value establishes the lowest level (darkest
tone) at which despeckling or noise removal begins. The Upper Limit
slider has values from 2 to 255. This value establishes the highest level
(lightest tone) at which noise removal ends. For example, if you want
to despeckle or remove noise in the shadow tones only, set the lower
limit to 0 and the upper limit to 64.
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Monitor Calibration Tips
If you want to use your monitor to evaluate halftones and color images
on the screen (commonly referred to as “soft proofing”), you must
calibrate your monitor. To reliably soft proof an image can save time
and money in proofs and printing jobs.

Calibration is the process of adjusting your monitor with the color
conversion parameters to compensate for various factors that affect
both the on-screen image and its conversion to printed output. These
factors include room lighting conditions, the type of viewing light
source, and the quality and settings of your monitor and display card.

For comprehensive instructions about how to calibrate your monitor,
refer to Calibrating Your System in the Adobe Photoshop User Guide.

Printing Tips
After you’ve processed your image so that you’re satisfied with it, the
next step is to prepare the image for your output device. You need to set
the lpi of your output image and then of your output device.

Setting the lpi of your output image

Selecting the lpi of your printer or imagesetter has a dramatic effect on
the quality of your printed image. The human eye needs to see at least
64 gray levels for good tonal evaluation. This is why you should
consider your output printing requirements before you begin setting the
ppi of your scanner. If you plan to photocopy, laser print or quick print,
don’t use line screens over 100 lpi.

Note: In most cases, you can use the setting for your printer’s default
screen ruling located in your graphics application.

If not, calculate the best lpi for your printer based on the resolution of
the printer (dpi), the line screen frequency (lpi) and the number of
shades in your halftone.
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Setting the lpi for your laser printer

Use the following table for setting the lpi of your laser printer.

Printer dpi lpi # shades optimal for

300 53 32

600 72 64 600 dpi laser proofing

600 85 50 newsprint proofing

800 100 64

800 85 88 newsprint proofing

1000 133 56 high resolution

1000 120 69 better tone

1000 100 100

1200 150 64 high resolution

1200 133 81 better tone

1200 100 120

For example, if you have a 600 dpi laser printer, you should use 72 lpi.
This provides 64 shades of gray. A setting of 85 lpi could also be used
in proofing newsprint, which provides about 50 shades of gray.

Setting the lpi for your imagesetter

Imagesetters typically have a dpi of 2400 or greater. At this resolution
level, it is the press that will determine the lpi. A sheet-fed, offset press
can reproduce screens as fine as 200 lpi or higher. Since many factors
determine the maximum lpi of the press, you should consult your print
vendor for this information.
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Multitone Tips
Duotones, Tritones and Quadtones (multitones) are useful in creating
sepia, old photo, and other colorization and special effects. Using two,
three or four inks to reproduce a single channel image not only creates
these wonderful effects but also increases the tonal depth of the image.
In either case, Intellihance can be used to increase the effectiveness and
consistency of Duotones, Tritones and Quadtones. Although you can
run Intellihance on images that have already been converted to the
Duotone mode, we suggest you enhance the grayscale image before
converting it to a duotone.

Processing an image for Multitone reproduction

When processing an image for Multitone reproduction, it is often
desirable to spread the tone of the image over the entire dynamic range,
sharpen it, and then remove noise from the image. Intellihance does all
this for you automatically.

If the image is old, you should set the Despeckle filter to Dark Tones
Only. You might want to preserve some of the image’s softness by
setting the Contrast filter to Soft. Once Intellihance has been run on the
grayscale image, it is ready to convert into a Multitone.

Converting an image to Multitone

The Adobe Photoshop manual describes several ways to convert an
image to a standard Duotone, Tritone or Quadtone.
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bitmapped  An image formed by a rectangular grid of pixels. The
computer assigns a value to each pixel, from one bit of information
(black or white), to as much as 24 bits per pixel for full color images.

calibration  Setting equipment to a standard measure to produce
reliable results from input to output. See also monitor calibration.

CMYK   (Cyan, Magenta, Yellow, Black) The subtractive primaries, or
process colors, used in color printing. Black (K) is usually added to
enhance contrast and to print a true black.

color correction  The process of adjusting an image to compensate for
scanner deficiencies or for the characteristics of the output device, or
the original film.

contrast  The relationship between the lightest and darkest areas of an
image.

dpi  (dots per inch)  A common measurement for describing the
resolution of input and output devices. See also ppi.

duotone  See multitone.

gamma  Measures the contrast that affects the midlevel grays
(midtones) of an image. Adjusting the gamma lets you change the
brightness values of the middle range of gray tones without dramati-
cally altering the shadows and highlights.

grayscale (GS)  The depiction of gray tones between black and white.

halftone screen  A pattern of dots of different sizes used to simulate a
continuous tone photograph, either in color or black and white.

Lab  The Lab color model is based on the original color model pro-
posed by the Commission Internationale d’Eclairage (CIE) in 1931 as
an international standard for color measurement.

lpi   (lines per inch) A measure of the frequency of a halftone screen
(usually ranging from 55-200). Originally, halftones were made by
placing an etched glass plate over an image and exposing it to produce
dots. Lpi refers to the frequency of the horizontal and vertical lines.

monitor calibration   The process of correcting the color rendition
settings of a monitor to match the colors of printed output.

multitone  Used to integrate one or more colors into a grayscale image
for a design effect.

Glossary
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pixel  (picture element) The smallest distinct unit of a bitmapped
image.

pixelization  If the image resolution is too low, the PostScript language
may use the color value of a single pixel to create several halftone dots
when printing. This results in pixelization, or blocky-looking output.

posterization  A flattening of highly saturated colors.

ppi  (pixels per inch) A measure of the amount of scanned information.
The finer the optics of the scanner, the higher the scan resolution.

quadtone  See multitone.

RGB  (Red, Green, Blue) The additive primary colors used for com-
puter monitor displays.

saturation  The strength or purity of color. Saturation represents the
amount of gray in proportion to the hue and is measured as a percent-
age from 0% (gray) to 100% (fully saturated).

screen frequency  The number of lines or dots per inch on a halftone
screen. Same as lpi.

tritone   See multitone.

white point  The reflective value that a scanner sees as white or 0%.
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Common Questions

Will Intellihance process every image correctly?

Intellihance processes most images in an optimum way. Users have
experienced a 1-7% fallout; although, it is interesting to note that often
it is hard to improve the fallout images beyond that of images processed
by Intellihance, even when starting from scratch. If image quality
degrades after running Intellihance with its default preferences, try
turning Contrast, Saturation and/or Brightness preference settings Off
and running Intellihance again.

Which scanners does Intellihance work with?

Intellihance works with all scanners—you can optimize images from
any source.

Will Intellihance work with my color management system?

Intellihance works well with color management systems both inside
and outside of Adobe Photoshop.

Does Intellihance require that my scanner be calibrated?

Intellihance works with both calibrated and uncalibrated scanners,
because it operates on color balance principles.

Can I run Intellihance multiple times?

Yes, running Intellihance again will often bring the image even closer
to your preferences.

Must I calibrate my monitor when using Intellihance?

If you plan to use the monitor display to evaluate the quality of the
image before you print, it is very helpful—although not required—to
calibrate your monitor. If you are evaluating grayscale images on the
monitor, then calibrate your monitor using the monitor preferences in
Adobe Photoshop. If you are evaluating color images on your monitor,
you should use a color calibration system.

My image looks good on the monitor but not in print.

You may need to calibrate your output device or monitor or both. Refer
to the “Advanced Tips” section beginning on page 20 in this manual for
more information.

My image lacks contrast.

Try reducing the Limits and Dot Gain from Adobe Photoshop. Also, try
increasing the Contrast filter setting or decreasing the Brightness
setting in the Intellihance Preferences dialog box.
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Registration

If you haven’t already registered, please complete the following registration information,
tear along the perforation and fax to (503) 274-0530 or mail it in the postage-paid envelope
provided. Your product registration number is located on the Intellihance disk.

Registration Number

Name

Organization

Street Address

City State Country Zip/Postal Code

Daytime Phone Daytime Fax

e-mail (optional) CIS AOL A-Link GEnie InterNet Other

Hardware Configuration (check all that apply)

❏ Pentium ❏ 486 ❏ Pentium Pro

❏ Modem ❏ Scanner ❏ CD-ROM ❏ Network

❏ Do you also use a Macintosh, Power Macintosh or compatible?

Photoshop Experience (check one)
❏ <6 months  ❏ 6 mo. – 1yr.  ❏ 1 yr. – 2 yrs.  ❏ 3 – 5 yrs.   ❏ >5 yrs.

Number of personal computers at site (check one)
❏ 1 ❏ 2–5 ❏ 6–10 ❏ 11–25 ❏ 26–50 ❏ >50

How did you learn about Intellihance? (check all that apply)
❏ Advertisement ❏ Review ❏ Bundle ❏ Demo ❏ Dealer
❏ Word-of mouth ❏ User Group ❏ Direct Mail ❏ Other___________________

Where did you purchase Intellihance?____________________________________________

What publications do you read? (check all that apply)
❏ PC Magazine   ❏ PC Computing  ❏ Windows Magazine ❏ Adobe Magazine  ❏ X-Ray
❏ Publish   ❏ Other______________________________________________________

Applications Used:
❏ QuarkXPress ❏ Corel Presents ❏ HiJaak ❏ KPT Convolver ❏ Lotus 1-2-3
❏ PageMaker ❏ Ventura Publisher❏ Director ❏ KPT Vector Effects ❏ Word Perfect
❏ Photoshop ❏ MS Publisher ❏ Premiere ❏ Andromeda ❏ MS Works
❏ Illustrator ❏ Harvard Graphics❏ Acrobat Exchange❏ ScanPrepPro ❏ MS Access
❏ FreeHand ❏ PhotoStyler ❏ Extreme 3-D ❏ Netscape ❏ Quicken
❏ Corel Draw ❏ Painter ❏ Strata Studio Pro ❏ MS Internet Explorer ❏ Visio
❏ Corel Photo-Paint❏ xRes ❏ Ray Dream ❏ MS Word ❏ PC Tools
❏ Corel Motion 3D ❏ PhotoDeluxe ❏ PageMill ❏ The Black Box ❏ Norton Utilities
❏ CorelDream 3D ❏ Canvas ❏ KPT ❏ MS Excel ❏ Uninstaller
❏ Alien Skin
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Suggestions

We’d like to know what you think we could do to make Intellihance
better. So if you have an idea for a new product feature, a modification
to an existing one, or anything else you can think of that will help us
make Intellihance better—we’d like to hear from you.

To help make Intellihance better:

A. 1. E-mail us at info@extensis.com

2. Describe your idea or comment, and include your name,
address, phone number and e-mail address.

OR,

B. 1. Print your name, address, phone number and e-mail address
below and sign your name.

2. Describe your idea or comment.

3. Tear along the perforation and mail or fax this sheet to
Extensis.

I understand that no compensation will be awarded for my suggestion.

My suggestion is...

Name

Street Address

City State Country Zip/Postal Code

Daytime Phone Daytime Fax

e-mail
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